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Introduction 
AppCenter is an application used to restrict user activity on mobile devices to a 
set of authorized programs and configurations. For example, to restrict users from 
accessing the Windows Start Menu, desktop, and Today screen. AppCenter 

replaces the desktop graphical user interface of a device with a secure launch 
screen that displays only approved programs and options. Any unauthorized 

program that attempts to start (either automatically or by user control) is 
immediately terminated.  

 
AppCenter can be configured to automatically launch approved programs at start 
up, for defined intervals, or in specific order. It can also be configured to disable 

the Windows Start Menu, on screen keyboard/SIP (Soft Input Panel), and other 
taskbar options. 

 
AppCenter is intended for use on mobile devices where only specific programs are 
allowed to be used. It can be configured to lock users out of critical and sensitive 

areas of the device. For example, a kiosk application where the user can only run 
a specified information application. The application is auto-started whenever the 

kiosk hardware is rebooted or the application is terminated. 
 
AppCenter works in two main modes: User Mode and Administration Mode. User 

Mode presents users with the AppCenter Launch Screen which lists applications 
that are approved for use. The user can only access the applications that are 

approved and configured for use. In Administration Mode, administrators can 
configure AppCenter by adding programs and enabling or disabling features for 
use. 

 
Note: AppCenter is only for Windows Mobile Phone Edition or Windows Mobile 

devices (Windows Mobile Pocket PC 2002 and higher versions) and is not intended 
for use on smartphone devices.  
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Installation 
This chapter discusses the installation procedures for Windows Mobile (WM) 
devices. AppCenter consists of several executable and configuration files. Some 
files are required to be loaded and/or created on the mobile device.  

Installation Procedures  

The installation procedures are used to install AppCenter on Windows Mobile 
devices. The installation is done by either copying the executable files (.exe) to a 

folder on the device or running an installation file (CAB).   
 

AppCenter requires that only the AppCenter executable file (.exe) be present to 
initially launch AppCenter on a Motorola mobile device. When AppCenter runs for 
the first time it will create the AppCenter.cfg file which contains the default 

Administration password of symbol. The password is used to log in to AppCenter 
Administration Mode. See Administration Mode on page 13 for more information. 

 
The initial launch will also create the AppCenter-User.cfg file which contains all the 
default pre-approved programs. The two configuration files will be created in the 

same folder as the AppCenter executable file unless the -config option has been 
used when launching AppCenter. See Command Line Options on page 15 for more 

information. 
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Motorola WM 5/6.x Devices (Cold Boot Persistent) 

The following procedures are used to install AppCenter on Motorola WM 5.x/6.x 

devices. WM 5.x and 6.x applications installed into volatile memory persist beyond 
a cold boot. For example, applications installed to dynamic storage other than 

Application, Platform or storage card folders will not survive a clean boot 
sequence.  
 

Note: For WM 5.x and 6.x phone devices and other WM installations where signed 
CABs are required, AppCenter CAB files are not signed by default.  

Install from Distribution CAB File 

The following CAB files are available for the installation:  

 AppCenter-WM5-MC9090.cab for MC9090 WM 5 devices 

 AppCenter-PPC-2.0.cab for WM 5/6.x devices 

Perform the following steps: 

1. Locate the CAB file in the Windows Mobile 5-6\ARM folder and copy it to 
the \temp directory on the device. The CAB file includes both AppCenter 
and AppCenter Administration executables.  

Note: For MC9090 devices running WM 5, use the AppCenter-WM5-
MC9090.cab file. For all other WM 5/6.x devices, use the AppCenter-PPC-

2.0.cab.  

2. Tap the CAB file to start the installation process.  

3. When prompted, select where to install AppCenter:  

 \Device (default)- installs AppCenter into a RAM storage memory 
location that can survive a cold boot.  

 \Application (or \Cache Disk)- installation to either of these 
folders may not prevent unauthorized access. At these locations,  

AppCenter may not install before other programs or applications in 
the cold boot sequence to prevent unauthorized activity.  
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Install from Distribution ZIP File Source 

Perform the following procedure to install AppCenter on a Motorola Windows 
Mobile 5/6.x device:  

1. Locate the Windows Mobile 5-6\ARM folder in the distribution source. 

2. Copy the AppCenter.exe and optionally AppCenterAdmin.exe to the 

\Application, \Device, or\Cache Disk folder on the device.   
 
Note: At the \Application or \Cache Disk locations, AppCenter may not 

install before other programs or applications in the cold boot sequence to 
prevent unauthorized activity. 

3. Double-click the AppCenter executable to run the application. 

Motorola WM 5/6.x Devices (Clean Boot Persistent) 

For clean boot persistence on a Motorola WM 5 device, install AppCenter using 
either Option 1 or 2 in this section. For WM 6.x devices, install AppCenter using  

Option 1. Notes: Access to the AppCenter distribution ZIP file source is required.    

Option 1 Install from Distribution CAB File 

WM 5 or WM 6.x Motorola Devices  

Perform the following steps on WM 5 or WM 6.x Motorola devices except  
WM 5 MC70, MC9090, MC75, and MC55: 

1. Locate the \Reset\WM5-6\Option1 folder in the ZIP file source. 

2. Copy the Install-AppCenter.run file from the folder to the 

\Application\StartUp folder on the device.  

3. Copy the AppCenter-PPC-2.0.cab file for the WM 5.x/6.x device to the 
\Temp folder on the device.  

4. Copy any AppCenter saved preferences (AppCenter-User.cfg) file to the 
\Application folder. This file can be created from Administration Mode to 

save the current settings. The file will be saved to the \Application folder 
automatically. 

5. Tap the CAB file to start the installation process.  

6. Select the option for \Application when prompted. 

7. Warm reset the device. 

8. Warm reset the device a second time. The device will restart and 
AppCenter should be running. 
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WM 5 MC70, MC9090, MC75, and MC55 Motorola Devices  

Perform the following steps on Motorola WM 5 MC70, MC9090, MC75, and MC55 
devices only: 

1. Copy the AppCenter-User.cfg, AppCenter.cfg, AppCenter.cpy, 
AppCenterAdmin and AppCenter (shortcuts) files from the \Reset folder to 

the \Application folder on the device. 

2. Copy the AppCenterAdmin.exe and AppCenter.exe files from the Windows 
Mobile 5-6\ARM folder to the \Application folder on the device.  

3. Tap the AppCenter-PPC-2.0.cab file to start the installation process.  
Note: For MC9090 devices running WM 5, use the AppCenter-WM5-

MC9090.cab file. 

4. Select the option for \Application when prompted. 

5. Perform a clean boot on the device. The device will restart and AppCenter 

should be running. 

Option 2 Install with Individual Files from Distribution ZIP File Source 

WM 5 Motorola Devices  

Perform the following steps on WM 5 devices. Note: This option is not required for 

WM 6.x devices. Perform the following steps: 

1. Locate the Windows Mobile 5-6\ARM folder in the distribution source. 

2. Copy the AppCenter.exe and optionally the AppCenterAdmin.exe files to 

the \Application folder on the device. 

3. Locate the \Reset\WM5-6\Option2 folder in the distribution source. 

4. Copy AppCenter.run and RegMerge_PlatID.run to the \Application\StartUp 
folder on the device. 

5. In the PlatformReg folder in the distribution source, locate the appropriate 

security registry file for the device. See the RegFile-Readme.txt file in the 
PlatformReg folder for information on what registry file is required for the 

device. 

6. Rename the appropriate security registry file (.reg) for the device and 
operating system to AppCenterPlat.reg and then copy this renamed file to 

the \Application folder on the device.  

7. Copy any AppCenter saved preferences file (AppCenter-User.cfg) to the 

\Application folder on the device. Note: This file can be created using 
AppCenter Administration and the file will be automatically saved to the 
\Application folder. 

8. Warm reset or cold reset the device. 
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WM 2003 Motorola Devices 

The following procedure is used to install AppCenter on a Motorola Windows 
Mobile 2003 device. Note: Access to the AppCenter distribution ZIP file source is 

required. 
 

Perform the following steps: 

1. Locate the appropriate files on the ZIP file source for the device operating 
system. For example, Pocket PC 2003 folder. 

2. Copy the following files to the \Application folder on the device to make 
AppCenter cold boot persistent: 

 AppCenter.exe (Pocket PC 2003 folder) 

 AppCenterAdmin.exe (only required when using the AppCenter 
Administration Mode on the device for application configuration) 

(Pocket PC 2003 folder) 

 AppCenter.cfg 

Note: If the AppCenter.cfg file is not located in the same directory as the 
executable(s), then the -config command line option is required.  

3. Perform one of the following procedures (A or B): 

A. Configure AppCenter using AppCenter Administration.  

  OR 

B. Use an existing AppCenter User Configuration by copying the 
AppCenter-User.cfg file. 

Note: If the AppCenter-User.cfg file is not located in the same directory 
as the executable(s), then the -config command line option is required. 

4. Copy the CPY file (AppCenter.cpy) in the \Reset folder to the \Application 

folder on the device. 

The CPY file can be used during the cold boot process to copy 

AppCenter.exe, AppCenterAdmin application, and corresponding shortcuts 
to the recommended pre-existing folders on the device. The file will copy 
the AppCenter executable (.exe) files to the \Windows folder and 

shortcuts to the \Windows\StartUp and \Windows\Start Menu\Programs 
folders.  

5. Copy the AppCenter and AppCenterAdmin shortcut files in the \Reset 
folder to the \Application folder on the device. The shortcut files are preset 
to launch AppCenter from the \Windows folder and instruct AppCenter to 

locate the configuration file in the \Application folder. Any changes made 
to the AppCenter configuration will be saved on a non-volatile partition 

and will survive subsequent cold boots.  
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User Mode 

Overview 

User Mode is the AppCenter interface that is visible to users. It provides controlled 
access to programs and device options from the AppCenter Launch Screen. The 

available programs and behavior of User Mode is configured by the administrator. 
AppCenter cannot be closed or shut down from User Mode.  

AppCenter Launch Screen 

The AppCenter Launch Screen is always active. The icons displayed on the screen 

include Windows icons or AppCenter controlled icons. If the taskbar is configured 
to contain the AppCenter Home icon, the user can toggle between an open 

application and the AppCenter Launch Screen by tapping the application and 
Home icons. Users can also switch between applications using the Smart Minimize 
button (done button) if configured for use. Note: The device arrow and enter 

keys can be used to select and access the available programs.  

Tools Menu 

The Tools menu contains Admin Login and Exit options. These selections may 
be disabled by the administrator. About is also included in this menu on Windows 

Mobile 2003 devices. 
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About 

The About menu shows version and build information about the AppCenter 

application installed on the device.  
 

 

   
 

Note: On Windows Mobile 2003 devices, About appears in the Tools menu. 
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Administration Mode 

Overview 

Administration Mode provides access to the Administration Options and Tools. It is 
password protected to allow only administrator access. Administrators can add, 

change and/or remove programs from the list of approved programs, and 
configure the taskbar to display or hide the Windows Start Menu, AppCenter 
settings or device status information.  

Configuring AppCenter  

After the initial installation of AppCenter is complete, AppCenter is ready to be set 
up for use. Setup includes configuring AppCenter behavior, options and approved 

programs. The AppCenter configuration details are created and written to 
configuration files from the settings made in AppCenter Administration Mode. 
AppCenter application behavior, such as launching the application, can also be 

controlled using command line options.   
 

Note: It is recommended to test configurations before deploying to cold boot 
environments as devices could be made inoperable because of a forgotten 
password or accidental deletion of a critical device process. 

Configuration Files 

The details of the configuration are contained in the configuration files 
(AppCenter.cfg and AppCenter-User.cfg). These files are located by default in the 
Program Files\Odyssey Software\AppCenter folder on the device. After 

installation, the files are created with specific default information determined 
during the initial run of AppCenter User Mode.  

 
The configuration files are automatically edited by the AppCenter Administration 
Mode application during the program approval process and general AppCenter set 

up. The configuration files can be exported and placed on additional devices to 
replicate the configuration options on other devices. See Appendix A Configuration 

Files for more information about the configuration file entries and format. 
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Log File 

The AppCenter Log File (AppCenter.log) is a text file located in Program 

Files\Odyssey Software\AppCenter on the device. This location can be changed 
using the -config command line option. See Command Line Options on page 15.  

The file can be accessed and read using a text editor. It also can be copied to 
other locations.  
 

The log file contains information about whether the AppCenter User Configuration 
File (AppCenter-User.cfg) was successfully loaded, and whether a default 

configuration file was created.  
 
The following is sample information that may be included in the log file: 

 
Loaded configuration file from: 

\Program Files\AppCenter\AppCenter-User.cfg 
 
No config file found. Creating default config file at: 

\Program Files\AppCenter\AppCenter-User.cfg 
 

Error! Unable to open existing config file at: 
\Program Files\AppCenter\AppCenter-User.cfg 

 
During an AppCenter User Mode session, all access violations to the configuration 
are written to the log file. See Log on page 32 for more information. Note: Not all 

windows included in the AppCenter Log must be approved. For example, on 
Windows Mobile 6 devices, the Desktop Explorer Window will appear in the log 

each time AppCenter is started. This window should not be approved. 
 
Each violation contained in the log file consists of the following:  

 general description of the violation. 

 date and time (PDT’s time) when the violation occurred. 

 process name of the offending process. 

 Window Title of the unapproved window (if present). 

 Window Class of the unapproved window (if present). 

 Window Action of the last action the window attempted before it was 
stopped. 

The following is a sample violation:  

Unapproved window detected. 
11/26/08 1:08:49 PM 

ExeName = cprog.exe 
Title = Phone 

Class = Dialog 
Action = Close window 
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Command Line Options 

Command line options can be specified when starting AppCenter. For example, to 

place the configuration files in non-volatile memory for cold boot recovery or log 
files in a subdirectory of \My Documents for easier location and access. Launching 

an application with command line arguments requires the creation of a shortcut 
and then editing the shortcut (.lnk file) to include the command line options.  
 

The following arguments can be used when configuring AppCenter: 

 -terminate– shuts down AppCenter and closes any applications that 

have the AutoStop option set. This option is ignored during 
AppCenter Administration Mode sessions. 

 -restart– shuts down AppCenter and closes any applications that 

have the AutoStop option set. AppCenter is then restarted, and any 
applications that have the AutoStart option set are started. This 

option is ignored during AppCenter Administration Mode sessions. 

 -silent– specifies whether AppCenter should display error messages 
on start up if the license key is missing, invalid or expired. When  

-silent is used, AppCenter shuts down without displaying an error 
message. 

 -config– specifies the directory location of the AppCenter 
Administration Configuration File (AppCenter.cfg), the User-Defined 

Configuration File (AppCenter-User.cfg) and the location of the Log 
File (AppCenter.log). This option replaces the -adminpath,  
-userpath, -logpath and -path options.  

Note: The file name(s) cannot be specified, only the path. If there 
are no command line arguments, all file locations are in the same 

folder as the AppCenter executables (Program Files\Odyssey 
Software\AppCenter\AppCenter.exe and AppCenterAdmin.exe).  
 

Examples: 

-config  \StorageCard\AppCenter\Config 

 
Double quotes are used if the path contains spaces:  

-config "\Program Files\AppCenter\Config"   
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Create a Shortcut 

To create a shortcut, use either ActiveSync or Athena to copy an existing shortcut 
(i.e. AppCenter.lnk) to the PC for editing or create a new shortcut on the desktop.  

 
The following is the shortcut format:  

99#XXXXXXXXXXXXXXXXXXXX  

Where 99# is the number of alphanumeric characters (left justified),  
# is a literal constant, and XXX is the complete command line.  

Any arguments in the command line that contain spaces must be enclosed in 
double quotes. Note: Multiple arguments cannot be enclosed within quotes as 

they will not be treated as separate arguments.  
 

Example: 

67#"\Windows\Start Menu\Programs\AppCenter.exe" -config "\Application” 
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Accessing Administration Mode 

To access Administration Mode: 

1. Select the AppCenterAdmin icon from Windows File Explorer or the 
Programs folder.  

OR  

In User Mode, tap Tools and then tap Admin Login. Note: This access 

method may not be available as it can be disabled by an administrator. 

2. The Admin Login screen appears. Enter the admin password. The default 

password is symbol. Note: It is recommended that this password be 
changed before deployment.  

 

 
 

After successful log in, the Administration Mode Screen appears. 
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Administration Tools  

The Tools menu contains selections for enabling programs for users, exiting 
Administration Mode and accessing AppCenter program information.   
 

To access, tap Tools and then tap a menu item.   
 

 

 
 
 

New Program 

The New Program selection is used to add programs which display as icons to 
the user on the AppCenter Launch Screen, allow processes to run in the 
background, or enable processes from other approved programs. See Adding 

Approved Programs on page 48 for the procedure and information about adding 
programs. 
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Admin Logout 

The Admin Logout selection exits Administration Mode and returns to the 

AppCenter Launch Screen.  

Exit 

The Exit selection will close both Administration and User Mode and return to the 
Windows Start (main) screen.  

 
Tapping ok at the top right of the Administration screen also exits the application.  

At the following dialog, tap Logout to exit Administration Mode or Exit to exit 
AppCenter completely. 
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Restore Default Programs 

The Restore Default Programs selection enables an administrator to undo all 

changes that were made during the session and revert the configuration back to 
the initial default (manufacturer) settings.  

 
The confirmation dialog displays before the configuration settings are actually 
reset. Tap Yes to confirm the reset. 
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Administration Options 

The Options menu is used to configure AppCenter program settings, such as 
Windows Start Menu appearance, and device status.  
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Taskbar 

The Taskbar tab selections are displayed when Options is tapped. Taskbar 

controls the appearance of icons on the taskbar at the top of the AppCenter 
Launch Screen when AppCenter is displayed in the foreground. These AppCenter 

program settings are contained in tabbed panels which are selected by tapping 
the corresponding name: Taskbar, Taskbar(2), Title, Time, Signal, Log, 
Admin, Browse, Close, Keys, Security, Phone, Icons, and View. The left and 

right arrows are used to scroll through the available tabs. 
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 Hide Start Menu- controls the appearance of the Windows Start 
Menu/taskbar and the done button when AppCenter is displayed in 
the foreground. When selected, the AppCenter taskbar displays and 

the Windows Start Menu/taskbar does not.  

Example: 

Hide Start Menu selected/checked (enabled) 

 
 

Hide Start Menu not selected/unchecked (disabled) 

 
 

The Hide Start Menu setting controls both the Windows Start Menu 
and done button settings for AppCenter only. Note: Hide start 

menu and Hide done button are separate settings for approved 
programs. 

When Hide Start Menu is not selected, the standard Windows 

taskbar is shown and is fully functional. When Hide Start Menu is 
selected, AppCenter controls the Windows taskbar and displays the 

AppCenter taskbar. When Hide Start Menu and Show standard 
taskbar icons are both selected, AppCenter partially controls the 
Windows taskbar. 

Notes for Windows Mobile 6.5 Devices 

 On Windows Mobile 6.5 devices, the done button is disabled and 

not actually removed from the task bar.  

 When setting Hide Start Menu to False on WM 6.5 devices, the 
following additional steps are recommended: 

1. Set HideStartMenu to False in Shell32. 

2. Add *|MSStartMenu to the approved Shell32 windows. 

3. Accessing the Start screen exposes the Home icon. To 
navigate to the Home screen from the Start screen, add 
*|DesktopExplorerWindow to the approved Shell32 

windows. 

 Selecting an unapproved application from the Start screen 

returns to the Launch Screen instead of the Start screen. 
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 Show Signal- displays the wireless network signal strength icon. 

 Show Home- displays the AppCenter home icon. The default is 
checked (enabled). When Show Home and Show standard taskbar 

icons are both selected, the home icon is displayed. 

Example: 

Show Home selected (enabled) 

 

 

 

 Show Battery- displays the current battery strength/battery status 
icon. When selected, the following setting becomes active:  

 Display battery level as percent- displays a charge level 
percentage instead of an icon. 

 Show AirBeam- displays the AirBEAM Safe status icon.  

 Show Volume- displays the speaker volume icon which enables 
volume control. Note: On Windows Mobile 6.5 devices running 

Windows Mobile 6.5 builds prior to build 23034, Show Volume is not 
supported when used in conjunction with Hide Start Menu. To work 
around this, deselect Show Volume and Volume keys allowed on 

the Keys tab or enable Show standard taskbar icons. If access to 
volume is required, select ShowStandardIcons. 

 Show WWAN- displays the Wireless Wide Area Network strength 
icon for devices that support the Radio Interface Layer (RIL.DLL). 
Note: Displaying both WLAN and WWAN signal strength at the same 

time uses the same amount of taskbar area as displaying WLAN or 
WWAN signal strength individually. 

 Show Time- displays the time of day. The default is selected 
(enabled). 

 Show connectivity- (Windows Mobile 5 and above only) displays the 
network connectivity icon. Connections include ActiveSync, Ethernet 
cradle, WLAN, WWAN, Bluetooth, GPRS, 1XRTT, Edge, 3G, HSDPA, 

and EVDO.  

 Show Date- displays the date. This setting can be used in 

conjunction with Show Time to display only the date, only the time, 
both or none. The date is displayed in the short format as specified in 
the Regional settings on the device. The taskbar date and time are 

displayed in the same font as the title.  
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 Show standard taskbar icons- works with Hide Start Menu to 
control taskbar functions and appearance. When this setting is 
selected, AppCenter uses fewer CPU cycles because it does not track 

information such as signal strength and battery usage. 

Note: The taskbar icons contain links to other programs. To allow 

user navigation to these programs, each program must be approved. 
See the Adding New Programs Procedure on page 51 for more 
information. 

Example:  

Show standard taskbar icons selected (Hide Start Menu not selected) 

 

Example:  

The Taskbar Screen selections made in the following graphic, produce the 

AppCenter taskbar shown below it.  
 
Task Bar Selections 

 

 
 
AppCenter Taskbar  
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 Disable standard taskbar taps- (Windows Mobile 6.5 devices) 
disables the Motorola SettingsUI program or Windows Mobile 6.5 
taskbar ribbon. When Show standard taskbar icons is selected 

with default AppCenter settings, the taskbar ribbon or SettingsUI 
program is approved and will display momentarily before it is hidden 

by AppCenter. Selecting Disable standard taskbar taps prevents 
any display of the taskbar ribbon or SettingsUI. All taskbar taps are 
ignored unless ShowHome is True, then tapping anywhere on the 

taskbar returns to AppCenter.  

To completely enable Motorola SettingsUI: 

1. Add SettingsUI.exe to the System approved EXE names.  

2. Select Show Standard taskbar icons for System. 

 

To completely enable the Windows Mobile 6.5 taskbar ribbon: 

1. Add *|Confettiplus* to the Shell32 approved window titles. 

2. Select Show Standard taskbar icons for Shell32. 
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Taskbar Icons 

The following table shows the icons that can be displayed in the taskbar.  
 
 

 

 
Battery 
Charging 

 

 

 
Battery Fully 
Charged 

 

 

 
Battery Good 

 

 

 
Battery Low 

 

 

 
Battery Very 
Low 

 

 

 
Battery 
Status 
UNKNOWN 

 

 

 
AirBEAM 
Status 
UNKNOWN 

 

 

 
AirBEAM 
Status 
CONNECTED 

 

 

 
AirBEAM 
Status  
NOT 
CONNECTED 

 

 

 
AirBEAM 
Status 
ROAMING 

 

or 

 

 
WLAN / 
Signal 
STRONG 

 

or

 

 
WLAN /  
Signal  
GOOD 

 

or

 

 
WLAN /  
Signal 
MEDIUM 

 

or

 

 
WLAN / 
Signal 
FAIR 

 

or

 

 
WLAN / 
Signal  
POOR 

 

or

 

 
WLAN /  
Signal 
NO SIGNAL 

 

 

 
Return to 
AppCenter 
(HOME) 

 

 

 
Speaker ON 
(Volume Up) 

 

 

 
Speaker OFF 
(Volume 
Muted) 

 

 

 
Volume set to 
VIBRATE 

 

or

 

 
WWAN / Phone 
STRONG  

 

or 

 

 
WWAN / 
Phone   
GOOD 

 

or

 

 
WWAN / 
Phone 
MEDIUM 

 

or

 

 
WWAN / 
Phone  
FAIR 

 

or 

 

 
WWAN / Phone 
POOR 

 

or 

 

 
WWAN / 
Phone  
NO SIGNAL 

 

 
 

 
Connectivity  
Icon 

 

 

 
Missed Call 
Icon 

 

 

 
SMS Message 
and Email 
Notification 

 

 

 
Alpha Keys 
Enabled 

 

 

 
Alt Keys 
Enabled 

 

 

 
Shift Keys 
Enabled 
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Taskbar(2) 

The Taskbar(2) tab controls the text, icons and taskbar background colors. Colors 

can be specified in decimal or hexadecimal format. See Specifying Colors on page 
46 for more information. 

 
The following colors can be specified for the taskbar: 

 Taskbar Color- specifies the color of the taskbar and taskbar icons 

based on a Windows Mobile OS color scheme or a customized color 
scheme. 

 Text Color- specifies the color of the text that displays in the 
taskbar. 

 Background Color- specifies the color of the taskbar background.  

 Font size/Bold- specifies the font size and weight for the taskbar 
title. Values in the range of 9-14 are recommended for best results. 

Values of 6-36 are allowed but may produce undesirable results. For 
example, depending on the enabled AppCenter taskbar options, a 
long title may not completely display in the AppCenter taskbar. 

Reducing the font size allows more of the title to appear. If a value 
outside the allowed range is used, the font size is reset to the default 

size (11). 
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Title 

The Title tab enables the creation of a custom title to display in the Launch Screen 

taskbar instead of the default AppCenter title.  

 Alternate Title- enter the text for a custom title that will appear in 

the taskbar. This title overrides the default AppCenter title.  

 Display MAC address as title- displays the device MAC address as 
the taskbar title. If a device does not have a MAC address, the 

AppCenter title appears.  

 Display IP address as title- displays the device IP address as the 

taskbar title. 

Example: 

 
 

Note: The adapter name must be correct on all devices to display the 

MAC or IP address as the taskbar title. 

 Always use AppCenter title- displays the current AppCenter title in 
all approved/accessible programs.  
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Time 

The Time tab enables customization of the time displayed in the Launch Screen 

Taskbar. To enable this setting, Show Time must be selected in the Taskbar tab.  

 Default- displays the hour (12 hour format) and time marker. For 

example, 11:59p.  

 24 hour- displays the time in 24 hour format. For example, 23:59. 

 Use regional settings- displays the time based on the current 

regional time. The following settings are enabled when Use regional 
settings is selected: 

 Do not use a time marker (AM/PM)- does not display AM/PM 
or international equivalents with the time. 

 Always use 24 hour format- displays 24 hour format at all 

times. 
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Signal  

Note: This setting is used for Motorola devices with 802.11x WLAN radios.  

The Signal tab enables a specific set of actions to occur if the AppCenter Launch 
Screen Taskbar Signal (WLAN) icon is tapped. To use these settings, Show 

Signal must be enabled in the Taskbar tab. Depending on the type of driver 
resident on the device, either Mobile Companion (Spectrum24 WLAN management 
application) or Fusion radio utilities are accessible. 

 Adapter Name- contains the resident 802.11x radio. This entry is 
automatically populated. 

 Do nothing- disables all the Signal tab selections. 

 Display Mobile Companion status- accesses the Mobile Companion 
status dialog.  

 Display Mobile Companion menu- accesses the Mobile Companion 
menu. 

 Display Fusion status- accesses the Fusion status dialog. 

 Display Fusion diagnostics- accesses the Fusion diagnostics 
application. 

 Display Fusion status or diagnostics- accesses the menu for 
Fusion status or diagnostics. 

 Display Fusion menu- accesses the full Fusion menu. 
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Log 

The Log tab enables viewing of the current AppCenter Log File entries. 

Information about whether the AppCenter User Configuration File (AppCenter-
User.cfg) was successfully loaded and information about the default configuration 

file is contained in the log. All attempted program launches or hardware keys 
presses that are not permitted (access violations) are captured in the log file. 
Viewing the log file for blocked applications helps the administrator define or 

troubleshoot the current AppCenter configuration (program access). Tap Clear 
Log to clear the current AppCenter log file. 

 
Not all unapproved windows that appear in the log need to be approved as 
sometimes these entries are the normal functionality of AppCenter. For example, 

AppCenter attempts to keep the start screen and desktop from being shown, but 
if they are shown, AppCenter will send them to the background and a log file 

entry is created, which is normal AppCenter behavior.   
 

 
 

Usage Example 

When approving a phone application, press the hardware key designated for send 
to discover the applications that are used for phone operation (usually Send and 
End buttons). AppCenter will monitor the phone application starting, but because 

the application is not approved, it will terminate the application and place the 
results of the violation in the AppCenter log file. View the log file which will 

contain the ExeName, windows Title, and Class entries necessary to add and 
approve the phone application.  
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Admin 

The Admin tab enables changing of the AppCenter current license key and admin 

password. AppCenter stores the admin password as a salted password digest. The 
default hash type is MD5 and the salt size is 8. Existing passwords will be 

converted automatically. Both MD5 and SHA hashes are supported with salt sizes 
of 0-32. Case sensitive passwords are supported. 

 New Password- enter the new admin password. 

 Confirm Password- enter the new admin password for confirmation. 

 Login disabled in user mode- disables Admin Login and Exit 

selections in the AppCenter Launch Screen Tools menu. 
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Admin Login Disabled 

If the Admin Login is disabled because the following factors exist, changing the 
AppCenter configuration of the device cannot be done using AppCenter:  

1. The Login disabled in user mode setting is enabled (Admin tab).  

2. The AppCenter Administration application is not approved and is not 

visible on the AppCenter Launch Screen. 

3. AppCenter starts automatically when the device is booted. 

To re-enable the login, use the Athena remote management application or 

ActiveSync to copy an unmodified version of the user configuration file 
(AppCenter_User.cfg) and replace the existing configuration file on the device. 

Reboot the device or restart AppCenter (AppCenter.exe) for the changes to take 
effect. The Admin Login option will then be available in the AppCenter Launch 
Screen Tools menu for accessing AppCenter Administration Mode.  

 
Example: 

 
AppCenter Launch Screen with Login Disabled 
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Browse 

The Browse tab defines the scope (folders and file extensions) of the program 

search when using the browse button to access the Select a program screen. On 
the General tab, the browse button appears to the right of the Description field 

when accessing Tools > New Program. See New Program on page 18 for more 
information. 
 

 
 
The Ext list contains the file extensions that are searched. The extensions are not 

limited to executable programs and are not case-sensitive. Note: Do not add a 
period (.) as part of the extension.  

 Include all shortcuts- allows the shortcuts to be visible when 

browsing. A shortcut must exist in the folders specified in the Folders 
list. Only executables whose file extension is registered in the Ext list 

will be displayed when browsing for programs. 

 Include control panel applets- locates and adds Control Panel 
(.cpl) applets to the search. For example, Owner Information or 

Clocks & Alarms.  
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Close 

The Close tab enables the administrator to control program executables to always 

stop (Always Close) and/or always start (Never Close) when accessed. The 
executables entered on this screen override any approved program definition in 

Administration Mode. For example, if an executable is defined as an approved 
program and is displayed on the Administration Mode Screen but the program 
executable name is in the Always Close list, the executable will be shut down 

immediately if accessed. 
 

 
 

 Always Close- contains the executable names that are always 

stopped when accessed. Use AlwaysCloseExe if Hide window 
displays in the AppCenter Log File but the program should be closed. 

AppCenter maintains an internal list of programs that will not be 
closed as closing these programs might be detrimental. You can 
override executables in this internal list by using AlwaysCloseExe.  
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 Never Close- contains the executable names that are always allowed 
to run when accessed. Use NeverCloseExe if Close window appears 
in the AppCenter Log File for a program that should never be closed. 

This is a program that is not approved, because users should not 
have access, but closing the program has undesired effects. After 

setting NeverCloseExe, AppCenter will hide the program window 
instead of closing it and Hide window will appear in the AppCenter 
Log File rather than Close window. 

Note: Some application dialogs (open and save) can enable unapproved 
programs to be launched when accessed. It is recommended to list or review 

specific entries for these applications when determining the Always Close 
executable list. 
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Keys (Phone Devices) 

The Keys tab enables the administrator to define the application launch capability 

of the volume (speaker/headset) and phone hardware device keys. This tab also 
determines whether the SIP is displayed from the AppCenter Launch Screen.  

 Hide SIP- disables the use of the on-screen keyboard. Note: On 
Windows Mobile 6.5 devices, when this option is selected, the SIP is 
not actually removed from the menu but does not function. 

 Disable phone key- (Motorola 9000 devices) disables the use of the 
phone key. The key is identified by a green icon or dot. 

 Volume keys allowed- enables the volume keys to function 
normally. 

 Show key states (not supported on Motorola ES400 and MC65 

devices)- displays an icon in the AppCenter taskbar when the Alpha, 
Func, Shift, Ctrl and Alt keys are enabled. Note: HideStartMenu 

must be selected and ShowStandardIcons must be deselected for 
key states to be displayed in the taskbar.  

 Blocked keys- allows AppCenter to be configured to block keys that 

open/access the Windows Start Menu. Tapping a value in the list 
enables the SIP for manual entry of values. The values are specified 

in hexadecimal format. For example, the ESC key is 0x1B.  

Multiple keys can be specified and wildcard characters are supported. 

For example, to not block any keys, remove all Blocked keys values. 
To block all keys, replace the values with an asterisk (*).  
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Debugging Blocked Keys Using the Log 

AppCenter logs information in the Log file each time a specified key is blocked. To 
debug a key configuration, use the following procedures. See Log on page 32 for 

more information. 
 

Approved Keys that are not working in AppCenter: 

1. Access Admin Mode. 

2. Tap Options and then tap the Log tab. 

3. Tap Clear Log to clear the current log information. 

4. Log out of Admin Mode. 

5. Press the key once. 

6. Access Admin Mode. 

7. Tap Options and then tap the Log tab. 

8. Locate the KeyCode value in the log. 

9. Tap the Keys tab. 

10. Remove the value from the Blocked keys list. 

 

Unapproved keys that are still working in AppCenter: 

1. Access Admin Mode. 

2. Tap Options and then tap the Log tab. 

3. Tap Clear Log to clear the current log information. 

4. Block all keys by adding * to the Blocked keys list. 

5. Tap the Keys tab. 

6. Log out of Admin Mode. 

7. Press the key once. 

8. Access Admin Mode. 

9. Locate the KeyCode value in the log. 

10. Tap the Keys tab. 

11. Replace the * setting with the KeyCode value. 
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Security 

The Security tab allows the administrator to define access to external files on 

memory cards (including AutoRun), and other devices. 

 Disable memory card insertion- (Pocket PC 2003 and above) 

disables memory card access. 

 Disable IR- (Pocket PC 2003 and above) disables the reception of IR 
(Infrared) data from other devices. 

 Disable Bluetooth- (Pocket PC 2003 and above) disables the 
Bluetooth radio on devices. Note: This setting does not always turn 

the Bluetooth radio off because of the many different Bluetooth 
implementations. 

 Disable ActiveSync- disables ActiveSync connections. If an 

ActiveSync connection is established when AppCenter starts, 
AppCenter closes the connection. Note: Closing an active connection 

on Windows Mobile 5 and above devices only works for devices using 
the RNDISFN1 adapter. 
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Phone (Windows Mobile 5 and above phone devices) 

The Phone tab allows the administrator to control access to the phone features on 

a phone device.   

 Voice Mail Phone Number- contains the phone number for voice 

mail. This phone number is called when the voice mail notification 
icon is tapped.  

The voice mail phone number can be a full phone number or a 

shortcut number, such as *86. If this setting is left empty, AppCenter 
will attempt to retrieve the device phone number and call that 

number. If AppCenter cannot retrieve the device phone number, it 
accesses the phone application. 

 Add phone menu to WWAN icon- (devices with RIL installed) 

enables access to the phone menu by tapping the WWAN icon on the 
taskbar. The menu contains selections for turning the phone on and 

off. Note: Show WWAN must be enabled in Options > Taskbar. 
See Taskbar on page 22 for more information. 

 Show phone icons on taskbar- enables access to phone 

notification icons (missed calls, unread text messages, voice mail) 
and displays these icons on the taskbar. After program approval, 

tapping the missed calls icon accesses the call log which shows only 
missed calls, text messages icon accesses the text message inbox, 

and voice mail icon accesses the phone which calls the voice mailbox.  

When this setting is enabled, the phone and messaging applications 
must be approved to support tapping the icons. To do this, add 

cprog.exe and tmail.exe to the approved executables for System. For 
the Palm Treo, also add *|DesktopExplorerWindow to the approved 

windows for Shell32. See EXEs on page 57 for more information. 

 Block incoming calls- disconnects (hang up) when an incoming 
phone call is received. 



AppCenter 
Windows Mobile Administrator Guide for Motorola  

 
 

Page 42 of 88  Odyssey Software, Inc. 

 Suppress SMS notifications- disable the SMS native client 
communication on the device. For example, check this setting to close 
new text message notifications when an SMS message is received.  

 Show today screen in xx seconds- (Windows Mobile 6.x phone 
devices) brings the Windows Today screen to the foreground after the 

specified number of seconds has passed. The left and right arrows 

 are used to specify the number of seconds. The default is 10 
seconds for Windows Mobile versions prior to Windows Mobile 6.5 and 

0 (disabled) for Windows Mobile 6.5 and higher devices. 

The phone application does not create the phone dialog window until 

the Today screen appears. If AppCenter or an application such as 
Pocket IE is configured to start with the device, the Today screen may 
not display and the phone button (green) cannot display the missing 

phone dialog. Unless the Today screen is approved, AppCenter will 
send the Today screen to the background.  

Note: AppCenter only uses this setting for WM 6.x devices with 
phones and only when the phone dialogs are missing. 
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Icons  

The Icons tab enables administrators to disable the icons on the AppCenter 

Launch Screen during an AirBEAM update or for a specific time period.  

 AirBEAM Update Disables Icons- disables the icons during an 

update of AirBEAM. 

 Disable Icons for 0 Seconds- disables the icons for a specific 

number of seconds. The left and right arrows  are used to enable 

and select the number of seconds. Note: On Windows Mobile 6.1 
devices where Hide menu bar is selected for IE, set this option to 10 
seconds.  

 

 



AppCenter 
Windows Mobile Administrator Guide for Motorola  

 
 

Page 44 of 88  Odyssey Software, Inc. 

View 

The View tab enables an administrator to customize the appearance of approved 

programs which appear to the user on the AppCenter Launch Screen. Programs 
will be arranged in columns depending on the length of the descriptions, the font 

size, and whether the device is in portrait or landscape orientation. 

 Large Icons- displays the program icons in a large size. 

 Small Icons- displays the program icons in a small size. 

 List- displays a list of program names centered on the screen. 

 Text Color- specifies the color of the icon text. The default is black 

(0x000000). 

 Background Color- specifies the color of the screen background. 
The default is white (0xFFFFFF). The background color is always used 

as the text background color. If a custom background bitmap is not in 
use, the background color is used for the entire AppCenter 

background. See Specifying Colors on page 46 for more information. 
Note: When using custom bitmaps as a background, set Background 
Color to match the predominant color of the bitmap. 

 Font size/Bold- specifies the font size and weight. 
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Example: 
 
Large Icons (Default) 

 

 
 

 
Small Icons 
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List 
 

 
 

 

Specifying Colors 

Colors can be specified in decimal or hexadecimal format. For example, 255 

(decimal) and 0x0000FF (hexadecimal) both specify bright red. Precede the 
number with 0x to specify hexadecimal. 

 
In hexadecimal format, the first two digits specify blue, the next two digits specify 
green and the last two digits specify red. Each two digits specify 256 shades of 

the color with 0/0x00 being darkest and 255/0xFF being lightest.  
When all three color settings are equal, varying shades of gray from white to 

black are specified.  
 
Note: A device may not be able to render all possible colors. If a color is not 

supported, the closest match is used. 
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Using Background Graphics  

AppCenter enables customization of the Launch Screen using a graphic file as a 
background. A background or logo bitmap (.BMP), Joint Photographic Experts Group 

(.JPG), Portable Network Graphics (.PNG), Graphics Interchange Format (.GIF), or 
Icon Image (.ICO) file can be used. The file naming conventions is AppCenter, 

AppCenter.jpg, or AppCenter.bmp, etc.  
 

Place the graphic file of the background or logo that you want to use in the folder 
which contains the AppCenter User Mode executable (AppCenter.exe file). For 
example, \Program Files\Odyssey Software\AppCenter folder.  

 
If colors in the bitmap are not supported on the device, the closest color is used.  

 
For best results, use the Text Color and Background Color settings on the View 
tab to coordinate the program descriptions with the bitmap. See View on page  

44 for more information. 
 

The bitmap should be large enough to cover the AppCenter Launch Screen. The 
minimum size should be a width equal to the device display and a height that is 

51 pixels less than the height of the device display (102 less on VGA devices).  
 

Example:  

For a 240 x 320 display, the minimum bitmap should be 240 x 269. Larger 
bitmaps can be used but will be clipped.  
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Adding Approved Programs 

Overview  

This chapter discusses adding programs which display to the user as selectable 
icons on the AppCenter Launch Screen. Approved programs may also allow other 

applications to run in background or run application sub-processes. 
 
Generally, there are two sources for a request to add approved programs to 

AppCenter:  

1. User community requirement to have the program to run on demand. 

2. Unapproved processes (recorded in the Log file) that AppCenter 
terminates, but which other programs require to run.   

The pre-approved applications and device operating system (OS) level functions 

(Calculator, Shell32, Symbol Radio, System) shown in the following illustration 
are created upon initial installation of AppCenter and are viewable in 

Administration Mode. The programs are added automatically to the configuration 
file.  
 

Note: It is recommended to test program configurations before deploying to cold 
boot environments as devices could be made inoperable by deleting a critical 

device process or a forgotten password. 
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Pre-approved Applications and Functions 

Pre-approved applications and functions are executables that Windows Mobile 
requires for operation. 

Pre-Approved Functions  

The following table contains approved device OS level functions.  

 
Warning: Some functions may be deleted, but use caution as device functionality 
may be impacted. 

 
 

ActiveSync Defines approval for 
ActiveSync auto-

connect when a PC 
makes an ActiveSync 
connection. 

 

CAB Files Defines approval that 
allows for CAB files to 

install when opened. 

Calculator Used as an example of 

a visible program. 
EXAMPLE ONLY 

Connection 

Manager 

Defines approval for 

dynamic network 
connections to 

automatically connect 
when media is 
attached. 

 

Dialup 

Networking 

Defines approval for 

dynamic WWAN 
network connections to 

automatically connect 
when network access is 
requested by 

applications. 
 

Fusion Defines approval for 

Motorola Fusion radio 
utilities. 

Mobile 
Companion 

Defines approval for 
Motorola S24 WLAN 

management 
application. 

 

Welcome Defines approval for 
the Welcome 

Application launched 
when Windows Mobile 

starts from a cold 
boot, allowing time 
zone and calibration 

changes. 
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Pre-Approved Applications 

The following list contains the applications with modifiable attributes that are  

pre-approved when AppCenter is first run: 

 Calculator (calc.exe)– used as a User Mode program example. 

 Dialup Networking (rnaapp.exe) 

 Connection Manager (connmgr.exe) 

 ActiveSync (repllog.exe) 

 CAB Files (wceload.exe) 

 Mobile Companion (nictt.exe)– for Motorola Spectrum24 radio 

devices. 

 Fusion (wclaunch.exe)- for Motorola Fusion radio devices. 

 Welcome (welcome.exe) 

 services.exe- OS level executable and custom services applications. 

Pre-Approved Applications Not Closed by AppCenter 

The following executable windows or processes will not be closed by AppCenter. 
The executables can be closed by adding the executable name in the Always 
Close list on the Close dialog. See Close on page 36 for more information.  

 
Warning: Use caution when closing OS level executables as this may cause the 

device to crash or become unstable.   
 

cemgrc.exe conmanclient.exe connmgr.exe ctlpnl.exe 

device.exe  evmon.exe filesys.exe gwes.exe 

keymode.exe nictt.exe nk.exe poutlook.exe 

rapisrv.exe remnet.exe repllog.exe rnaapp.exe 

services.exe shell32.exe srvtrust.exe tmail.exe 

toolbox.exe udp2tcp.exe wclaunch.exe welcome.exe 

 

The following pre-approved executables should not be deleted or configured 
further as basic device functionality can be negatively impacted or the device may 
be disabled. 

 Device (device.exe)- defines approval for dynamic plug and play 
operation.  

 GWES (gwes.exe)- defines approval for OS level windowing 
functions.  

 Shell32 (shell32.exe)- defines approval for Windows Classes static, 

worker, dialog used in message boxes, and other built-in alerts. 
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Adding New Programs Procedure 

This procedure creates an approved program that can be accessed by AppCenter 
users.  

1. Tap New Program from the Tools menu. 

OR 

Hold the stylus on a program icon until the menu appears, then tap New. 

Note: The device arrow and enter keys can also be used to select and 
access the program. 
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The General tab displays for configuring the program attributes of the 
new program. The program settings are accessed by tapping the tabs at 
the bottom of the screen. The settings on the tabs only pertain to this 

program. The left and right arrows are used to scroll the tabs. 

2. If the program is installed on the device and its location is defined in the 

paths specified using Options > Browse, tap the browse button  and 
continue to the next step.  

3. If the program is not installed on the device or to configure the program 

manually, skip to step 5.   
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4. The browse button accesses the Select a program screen which shows the 
available programs for approval. Tap a program to automatically populate 
the entries in the General and Exes tabs based upon the program 

attributes defined in the registry and other OS level resources. See 
Browse on page 35 for more information on configuring the program 

search criteria. 

 
 

 
 

 

5. Manually, configure the program attributes in each tab. See Defining New 
Program Attributes on page 56 for information about the attributes 

located on the New Program screen tabs.  

6. When finished, tap Save. The program is now approved and viewable in 

the AppCenter Launch Screen. 
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Editing and Deleting Approved Programs 

Existing approved programs can be modified or removed from AppCenter. 

Edit Program 

An approved program can be modified by holding the stylus on the desired 
program until the options menu appears. Tap Edit to access the program 

attributes. 
 
 

 
 

  



AppCenter 
Windows Mobile Administrator Guide for Motorola 

 
 

Odyssey Software, Inc.  Page 55 of 88 

Delete Program 

An approved program can be deleted by holding the stylus on the desired 

program until the options menu appears. Tap Delete, and then when prompted, 
tap Yes to confirm the deletion. 
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Defining New Program Attributes 

This section discusses the entries that are used to configure programs for use with 
AppCenter.  

General 

The General tab contains the following entries: 

 Description- specifies the icon program/title on the AppCenter 
Launch Screen.  

 Execute- specifies the full path and file name of the process that is 

launched for the program. See EXEs on page 57 for more information.  

 Arguments- allows the specification of any command line arguments 

required for running the program.  

 Icon File- specifies the full path and file name of the executable 

whose icon will be used as the icon on the AppCenter Launch Screen. 
Typically, this entry contains the same file name as the Execute 
entry. Portable Network Graphics (PNG) files are supported but are 

resized to 32x32 or 16x16 depending on the ViewMode setting in use.  

 Save- save all the information on all tabs. 

 Cancel- cancel all modified entries since the last Save was 
performed.  
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EXEs 

The EXEs tab allows the manual entry of a specific executable (.exe files) to use 

when launching a process that is identified in the Execute entry on the General 
tab. Approved EXE Names specifies an executable file if Execute contains the 

full path and file name to a non-executable file. 
 
More than one executable can be specified for approved programs. Normally, one 

executable is specified per approved program. If there are multiple approved 
programs which are identical except for the executable, these approved programs 

can be consolidated into one entry.  
 
For example, OS programs such as device.exe and gwes.exe (required to set a 

device password and enable the password dialog in AppCenter) that are not used 
for launching a program but are only used for approving system windows. Another 

example is an approved program that launches additional programs. 
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Example:  

A Pocket Word document named Letter1. Execute on the General tab contains 
\My Documents\Letter1.psw which is a path to non-executable file. Approved 

EXE Names would contain pword.exe which is the associated Pocket Word 
program executable.  
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Windows 

The Windows tab restricts the approved program to only display windows whose 

Title and Class attributes match the specification in the Approved Window 
Titles list. The default entry *|* is used for most approved programs (specified in 

the EXEs tab) as the only approved window. Approved windows apply only to the 
approved program to which they are associated.  
 

The format for an entry is {WindowTitle}|{WindowClass}. 
 

The following characters can be used in an approved window string: 

 |- divides Title from Class. 

 *– wildcard. Match up to the first occurrence of *. Characters after * 

are ignored. 

 ?– match for one character position. 

 \- match the next character exactly. For example, if a window title 
contains a backslash enter \\ or enter \| if the title contains a | 
character. 
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The following formats are supported for approved windows: 
 

Format Definition 

Title or Title| or Title|* Match title. Any class allowed. 

Title|Class Match title and match class. 

|Class Match blank title and match class. 

| Match blank title and any class. 

*|Class Any title allowed. Match class. 

abc*|xyz* Match any title starting with abc and match any 
class starting with xyz. 

 

Identify Window Title and Class 

To identify the program windows Title and/or Class, perform the following: 

1. Remove the default entry *|*.  

2. Save the configuration and run the program from the AppCenter Launch 
Screen. The program should not display many (if any) windows.  

3. Re-enter AppCenter Administration and examine the log file using  

Options > Log. The unapproved window Title and Class will be listed and 
can then be added to the list.  

Note: Adding *|* as an approved window for Shell32.exe will allow all settings 
applets to be used. Generally, only approve windows for settings the user is 
allowed to change. 

Windows Mobile 6.5 

In Windows Mobile 6.5, the Start Screen (*|MSStartMenu), desktop and the 

confetti bar are areas that allow programs to be launched. For security reasons, 
AppCenter does not approve any of the following windows by default:  
 

Program Shell32 ApprovedWindow    *|MSStartMenu 
Program Shell32 ApprovedWindow    *|DesktopExplorerWindow 

Program Shell32 ApprovedWindow    Desktop|DesktopExplorerWindow 
Program Shell32 ApprovedWindow    "TitleBarList|CONFETTIPLUS TITLEBARLIST" 
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Guidelines to Consider When Approving Programs  

The following guidelines should be applied when approving programs: 

1. An ExeName entry for a specific EXE should appear only once in the 

configuration file. 

2. *|* should be the only Approved Window setting for an approved 

program. 

Note: In most cases, guidelines 1 and 2 should always apply. An 
exception is when approving control panel applets that use the same EXE 

to launch different applets. For example, to approve only the Backlight 
and Power applets. The same ExeName setting for both will be used and 

the Approved Window settings that applies only to these applets will be 
specified. Another exception to guideline number 2 is when a user 
requires access to a subset of screens in a program. 

3. If you have defined *|* as an Approved Window for a program, do not 
add any additional Approved Window settings.  

Example: 

If *|xyz is defined, there is no need to approve any other windows that 

end in |xyz, such as abc|xyz and 123|xyz, as they are included with 
*|xyz. Avoid placing anything other than * in front of the | symbol as this 
prevents AppCenter from checking the window title and allows AppCenter 

to operate more efficiently. With some unresponsive programs, checking 
the window title is not possible. 

4. If all windows for a program need to be approved and it is not required for 
the user to launch the program, add an ExeName setting to the system 
approved program rather than creating a new approved program. In 

general, when HideFromUser is set to True, a separate approved 
program for that EXE is not required. The exception would be when not 

approving all windows for the EXE. 

5. Not all windows included in the AppCenter log must be approved. For 
example, on Windows Mobile 6 devices, the Desktop Explorer Window will 

appear in the log each time AppCenter is started. This window should not 
be approved. 

6. If an application is not processing messages, AppCenter cannot retrieve 
the application's window title. AppCenter waits 2 seconds and if the title 
cannot be retrieved, sets the title to Unavailable. To approve an 

application that does not process messages, the recommended method is 
to approve *|*. If this is not an option, add Unavailable as an approved 

window, for example, Unavailable|Dialog. 
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Options 

The Options tab specifies how to display the AppCenter Launch Screen icons for 

the program and how the program will interact. When an item is selected or 
checked, the setting is enabled for the program.  

 Hide from user- prevents the program from appearing in AppCenter 
(AppCenter Launch Screen).   

 Hide SIP- disables the on screen keyboard.  

 Hide menu bar- prevents the program’s command bar from 
appearing while the program is active.  

 Read-only- disables modification of the approved program when 
using Administration Mode. 

 Hide start menu- hides the Windows Start Menu/taskbar. This 

setting also disables Time/Next Appointment icons while the program 
is active. The default setting is checked (enabled).  

 Hide done button (X)- hides the done button.  

 Always launch program- allows a program to launch each time it is 
accessed, overriding AppCenter default program behavior. Use this 

setting when multiple launches are required, a program prevents 
multiple launches internally, or if tapping an icon fails to launch a 

program. By default, AppCenter launches a program the first time it 
is tapped and caches the program’s window handle. On subsequent 

taps, the cached window is brought to the foreground. This prevents 
multiple launches of the same program. For Athena.exe, Always 
Launch Program should be selected. 

Note: The default for Always launch program is not selected 
because not all programs can handle being launched multiple times. 

Most Windows Mobile programs do an internal check for a running 
instance and bring the instance to the foreground.   
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 Disable relaunch for 0 seconds- disables an icon for a specified 
time period as the program is accessed to prevent multiple launches 
of the same program. This setting can be used for applications that 

take a long time to initialize and start. For example, .NET Compact 
Framework. The left and right arrows are used to enable and select 

the number of seconds.  
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Examples:  
 
Start Menu Visible 

 

 
 

 
Start Menu Hidden 
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Done Button (X) Visible 
 

 
 

 
Done Button (X) Hidden 
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Menu Bar Visible 
 

 
 

 
Menu Bar Hidden 
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Options(2) 

The Options(2) tab specifies whether to display the program in the Tools menu, 

enable the volume keys, and display the taskbar icons when the program is 
running. When an item is selected or checked, the setting is enabled for the 

program. 

 Add to tools menu- places the program description on the 
AppCenter Tools menu. Tapping the program name launches the 

program from the Tools menu. If Hide From User is set, the 
program appears only on the Tools menu, otherwise, the program 

also appears as an icon on the AppCenter Launch Screen. 

 Volume keys allowed- enables the volume hardware keys when 
using the program. The default setting is checked (enabled). 

 Show standard taskbar icons- displays taskbar icons when the 
program is running. The taskbar icons contain links to other approved 

programs. Note: It is recommended that this setting also be enabled 
for Shell32.exe. Otherwise, when a taskbar icon is tapped and a 
notification dialog appears, the taskbar returns to the AppCenter 

taskbar. See Taskbar on page 22 for more information on the display 
and behavior of the taskbar. 
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Startup 

The Startup tab specifies how the program automatically starts and/or stops when 

AppCenter opens or closes.  

 Start when Appcenter starts- launches the program when 

AppCenter starts. 

 Stop when Appcenter stops- closes the program when AppCenter 
exits or is terminated. 

 Delay start for 0 seconds- specifies a delay before the program is 
launched. This setting is enabled when Start when Appcenter 

starts is selected. For example, to aid in sequencing the launch of 

multiple programs by AppCenter. The left and right arrows  are 
used to enable and select the number of seconds. The maximum 

startup delay is 120 seconds. Note: On Windows 6.1 devices where 
IE is automatically started, set this option to 10 seconds. 

Note: If no setting is specified, the program can be started if it is not hidden.   
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Connectivity 

The Connectivity tab enables the program for required device IP addresses or 

access points. When both Required IP and Required SSID are used, both 
requirements must be met for the program to be enabled. The default setting is 

nothing selected (blank).  

 Required IP– selects device specific IP address(es). A specified IP 
address must match an IP address currently available on the device.  

 Required SSID– selects a specific access point to which devices are 
associated. A specified SSID must match the current SSID on the 

device. 

The wildcard characters * and ? can be used when specifying the IP 
and SSID entries: 

 * matches any sequence of characters.  

 ? matches any one character.  
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Appendix A Configuration Files 
The Configuration file definitions and format in the appendices is provided for 
informational purposes only. Configuration files are automatically edited by the 
Administration Mode application (AppCenterAdmin.exe).  

 
Note: Manual editing of the configuration files is not recommended.  

AppCenter Configuration (AppCenter.cfg) 

The AppCenter configuration file contains the license and administrative password 
settings. The license setting is required for AppCenter to run and is built into the 

Motorola OEM version of AppCenter.  
 
If a password setting is not supplied, AppCenter will create the password setting 

with the default value of symbol. When AppCenter is launched it will automatically 
encrypt the password and save it to the configuration file.  

AppCenter User Configuration  

(AppCenter-User.cfg) 

The AppCenter-User configuration file contains configuration options for approved 
programs, general appearance, and functions of the AppCenter application. The 
file is auto-created if it does not exist when AppCenter is initially run. All 

Administration actions performed using AppCenter Administration are captured 
and saved to this file.   

System Options 

The system options settings are used when AppCenter is displayed in the 
foreground. These options are arranged in the configuration file in the Taskbar, 
Title, Time, Signal, Admin, Browse, Close, Key, Security, Phone, Icon, and View 

Options sections, which correspond to the Administration Mode Options tabs. See 
Appendix B Sample Configuration for a sample file layout. 
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Taskbar Options 

See Taskbar on page 22 for more information. 
 

HideStartMenu– disables or hides the Windows Start Menu/taskbar and done 
button. The default value is True (enabled). In Windows Mobile 6.5, when this 

option is selected/enabled (True), the Windows Start Menu/taskbar and done 
button are not actually removed from the task bar but are not functional. 
 

ShowHome– controls the display of the Home icon on the AppCenter taskbar. 
The Home icon is used to return to the main AppCenter Launch Screen. The 

default value is True (enabled). 
 
ShowBatteryLevel– enables an icon on the AppCenter taskbar that will indicate 

the current battery strength. The default value is True (enabled). 
 

ShowVolume– enables the volume icon and volume slider control in the 
AppCenter taskbar. The default value is False (disabled).  

 
BatteryPercentFormat– changes the battery display (indicates the remaining 
battery charge) from an icon to a percentage. The default is False (disabled).  

 
ShowAirBeam– enables an icon in the AppCenter taskbar that will indicate 

whether AirBEAM Safe is connected, roaming, or disabled. The default value is 
False (disabled). 
 

ShowSignalStrength– enables an icon on the AppCenter taskbar which indicates 
the wireless LAN network signal strength. The default value is True (enabled). 

 
ShowConnectivity– (Windows Mobile 5 and above) controls whether a network 
connectivity icon is displayed on the taskbar. The icon indicates whether or not 

there is any connection available. All connection types are supported, including 
ActiveSync, Ethernet cradle, WLAN, WWAN and Bluetooth. The default is False 

(disabled).  
 
ShowWwanSignalStrength– controls the display of the WWAN signal strength 

in the taskbar on devices that support the Radio Interface Layer (RIL.DLL). See 
Signal on page 31 for more information. 

 
ShowTime– displays the current time on the AppCenter taskbar. The default 
value is True (enabled). 

 
ShowDate- displays the date on the taskbar. ShowDate can be used in 

conjunction with ShowTime to display only the date, only the time, both or none. 
The date is displayed in the short format as specified in the device Regional 
settings. The default value is False (disabled).  
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ShowStandardIcons– controls taskbar functionality and is used in conjunction 
with the HideStartMenu setting. The default value is False (disabled).  
 

DisableStandardIconTaps (Windows Mobile 6.5)– disables the Windows Mobile 
6.5 taskbar ribbon or Motorola SettingsUI program. The default value is False 

(disabled).  
 
TaskbarTextColor– controls the color of the text and icons on the taskbar. The 

default value is 0 which calculates the color based on the Windows CE version. 
 

TaskbarBackgroundColor– controls the color of the taskbar background. The 
default value is 0 which calculates the color based on the Windows CE version. 
 

Title Options 

See Title on page 29 for more information. 

 
AlternateTitle– contains a custom AppCenter title for display in the taskbar. The 

default is an empty string which displays the default Motorola AppCenter title. 
This setting supports special tokens designated by placing the keywords inside 
square brackets. If a token is invalid, [Invalid Token] will display as the title. If a 

token is not supported on a device, [Not Supported] will display as the title.  
 

Specifying an AlternateTitle of [ESN] (Electronic Serial Number) displays the 
results of the Motorola GetESN function as the title. Note: Not all Motorola 
devices support this function. Some devices will return 0000000000000000 as the 

serial number. The System Info applet under Settings can be used to check the 
value of ESN. 

 
Specifying an AlternateTitle of [UUID] displays the results of the Motorola 
GetUniqueUnitIdEx function as the title. Note: Most Motorola devices support this 

function. The System Info applet under Settings can be used to check the value of 
UUID. 

 
Specifying an AlternateTitle of [DeviceID] displays the results of 
IOCTL_HAL_GET_DEVICEID as the title. This is a generic call that can be used on 

all Windows Mobile devices. Often the results of UUID and DeviceID are identical. 
 

Specifying a registry key and value inside square brackets will display the registry 
value as the title. Only string values are supported. A full registry key should be 
specified followed by a colon and the value name (no spaces). If the default value 

for the registry key is desired, omit the colon and value name.  
 

Examples: 
 
AlternateTitle [DeviceID] 
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AlternateTitle "[HKEY_LOCAL_MACHINE\SOFTWARE\XYZ Incorporated]"  
(Default value) 
 

AlternateTitle "[HKEY_LOCAL_MACHINE\SOFTWARE\XYZ Incorporated:Title]" 
 

DisplayIpAddress– enables the current IP address of the device as the taskbar 
title. DisplayIpAddress defaults to False (disabled). If a device does not have an 
IP address, the alternate or default AppCenter title is displayed. 

 
DisplayMacAddress– enables the current MAC address of the device as the 

taskbar title. DisplayMacAddress defaults to False (disabled). If a device does 
not have a MAC address, the custom alternate or default AppCenter title is 
displayed. If both DisplayMacAddress and DisplayIpAddress are set to True 

(enabled), the MAC address is displayed. 
 

TitleBold– specifies the font weight of the taskbar title. The default value is 
selected (enabled). 

 
TitleFontSize– specifies the font size of the taskbar title. The default value is 11. 
AlwaysUseAppCenterTitle– uses the currently configured AppCenter title as the 

taskbar title rather than the title of the program in the foreground. The default is 
False (disabled). 

 

Time Options 

24HourTimeFormat – controls the time display between 12 hour format 

(11:59p) and 24 hour format (23:59). The default is False (disabled).  
 

RegionalTimeFormat– enables the current regional time settings for the time 
display in the taskbar. The default is False (disabled). When 
RegionalTimeFormat is set to True, the 24HourTimeFormat setting is ignored. 

 
RegionalTimeOptions– enables regional options when the regional time display 

is specified. This setting is ignored unless RegionalTimeFormat is set to True 
(enabled). The default setting is 2, which removes seconds from the time display. 
The default setting is always enforced regardless of what other options are set. If 

an invalid option number is specified, all options are ignored. The following 
settings are supported: 

 1- only display the hour. Do not display minutes or seconds. 

 2- (default) only display the hour and minutes. Do not display 
seconds. 

 4- do not display AM or PM or international equivalents. 

 8- always use 24 hour format. 
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Signal Options 

See Signal on page 31 for more information. 
 

AdapterName– controls which adapter is used to retrieve the IP or MAC address. 
This setting is used in conjunction with DisplayIpAddress and 

DisplayMacAddress. Partial matches are supported. For example, an 
AdapterName of NETWLAN1 would match an adapter named NETWLAN1 or 
CTIP\NETWLAN1. If no match is found for AdapterName, the default or alternate 

AppCenter title is displayed regardless of the DisplayIpAddress and 
DisplayMacAddress settings. Note: AppCenter attempts to automatically set 

this value to the device 802.11b radio if AdapterName is not provided. 
 
FusionMode– controls access to the Motorola Fusion radio utilities. The first time 

AppCenter is run, this setting is created with the default value of 0 (no action). If 
this setting is greater than 0, it will override the MobileCompanionMode setting. 

The following values are supported: 

 0- no action is taken.  

 1- run the Fusion status application. 

 2- run the Fusion diagnostics application. 

 3- show a menu for status or diagnostics. 

 4- show the Fusion menu. 
 

MobileCompanionMode- controls access to the Spectrum24 WLAN management 
application when the signal strength icon is tapped. The first time AppCenter is 
run, this setting is created with the default value of 2 (display menu). The 

following values are supported: 

 0- take no action. 

 1- launch Mobile Companion Status dialog. 

 2- (default) display the Mobile Companion menu. 

 

Admin Options 

See Admin on page 33 for more information. 

 
AdminLoginDisabled– controls the appearance of the Admin Login entry in the 
User Mode Tools menu. The default is 0 (enabled). If set to 1, the login is disabled 

and is not visible in the Tools menu. 
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Browse Options 

See Browse on page 35 and Appendix B Sample Configuration for more 
information. 

 
BrowseAllShortcuts– displays all shortcuts in the list of programs that can be 

approved on the Select a program screen. The setting defaults to True (enabled). 
If set to False, only shortcuts whose target file extension is in the 
BrowseExtension setting will be visible. By default, all shortcuts defined in the 

BrowseFolder setting are listed. 
 

BrowseFolder– overrides the default folders that are searched when browsing 
for a program to approve on the Select a program screen. All subfolders of the 
specified folders are also included in the search. The following list contains the 

default folders:  
 

\Windows\Start Menu 
\Windows\Startup 

\Windows\Programs 
\Program Files 
 

BrowseExtension– specifies the default file extensions searched when browsing 
for an approved program on the Select a program screen. The extensions used 

are not limited to executable programs and are not case sensitive. For example, 
document file extensions (doc) can also be used. Note: Periods are not used as 
part of the file extension. Normally, shortcuts are always browsed regardless of 

the target file extension. The shortcut browse behavior is controlled by the 
BrowseAllShortcuts setting. The default extensions are exe and vb. 

 
BrowseControlPanel– includes control panel applets when browsing for an 
approved program on the Select a program screen. The default is True (enabled). 

 

Close Options 

See Close on page 36 for more information. 
 
NeverCloseExe/AlwaysCloseExe– attempts to send all unapproved windows to 

the bottom of the Windows z-order, then, determines the executable name of the 
window owner. If the executable name is not on the internal list of Windows OS 

processes, AppCenter attempts to close the window. In most cases, the 
application is shut down.  
 

AppCenter never attempts to close a window that belongs to an executable listed 
under the NeverCloseExe setting. These windows are sent to the bottom of the 

z-order. AppCenter always attempts to close windows that belong to an 
executable listed under the AlwaysCloseExe setting. 
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Example: 

AlwaysCloseExe always1.exe 
AlwaysCloseExe always2.exe 

NeverCloseExe never1.exe 
NeverCloseExe never2.exe 

 

Key Options 

See Keys (Phone Devices) on page 38 for more information. 

 
BlockTaskbarKey– blocks the keys that access the Windows Start Menu. On 

different devices, different keys access the Start Menu. This means that not all 
listed default settings are needed on every device and could interfere with desired 
behavior. The values are specified in 2 digit hexadecimal format. For example, the 

ESC key is 0x1B. Note: This setting only affects keys received by the taskbar.  
 

VolumeKeysAllowed– enables the volume hardware keys. The default is True 
(enabled). 

 
DisablePhoneKey– (Motorola 9000 devices) disables the phone key on Motorola 
9000 devices. The phone key (identified by a green icon or dot) launches the 

phone application. The default is False (disabled).  
 

HideSip– controls the display of the SIP in AppCenter User Mode. The first time 
AppCenter is run, this setting is created with the default value. The default is True 
(enabled). In Windows Mobile 6.5, when this option is selected/enabled (True), 

the SIP is not actually removed from the menu but is not functional. 
 

ShowKeyStates (not supported on Motorola ES400 and MC65 devices)– displays 
an icon on the AppCenter taskbar for the current state of the Alpha, Func, Shift, 
Ctrl and Alt keys. HideStartMenu must be selected and ShowStandardIcons 

must be deselected for key states to be displayed. The default is False (disabled). 

Security Options 

See Security on page 40 for more information. 
 
DisableMemoryCardInsert– (PocketPC 2003 and above) prevents memory 

cards from being mounted in the file system. This also prevents any auto-run 
programs on memory cards from running. The setting defaults to False (disabled). 

 
DisableIR– (PocketPC 2003 and above) disables the Beams > Receive all 
incoming beams setting in the Control Panel. This renders a device incapable of 

automatically receiving IR data from another device. The setting defaults to False 
(disabled). 
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DisableBluetooth– (PocketPC 2003 and above) disables the Bluetooth radio on 
devices that have a Microsoft-implemented Bluetooth stack (StoneStreetOne). 
The setting defaults to False (disabled). 

 
DisableActiveSync– prevents a device from connecting via ActiveSync. If an 

ActiveSync connection is established when AppCenter starts, AppCenter will close 
the connection. For Windows Mobile 5 and above devices, the setting works only 
on devices using the RNDISFN1 adapter. The setting defaults to False (disabled). 

 

Phone Options 

See Phone (Windows Mobile 5 and above phone devices) on page 41 for more 
information. 
 

AddWwanPhoneMenu– (RIL devices) controls whether a menu appears when 
the WWAN signal strength icon is tapped. The default is False (disabled). The 

ShowWwanSignalStrength setting must be enabled for this setting to be used.  
 

BlockIncomingCalls– (Windows Mobile 5 and above only) controls the action 
taken when a phone call is received by the device. The default for this setting is 
False (disabled). When set to True, AppCenter will disconnect the phone whenever 

an incoming call is detected.  
 

ShowPhoneIcons – (Windows Mobile 5 and above only) controls the appearance 
of icons for missed calls, unread text messages, and voice mail. The icons provide 
access to associated applications. The default for this setting is False (disabled). 

See EXEs on page 57, Windows on page 58 and Phone (Windows Mobile 5 and 
above phone devices) on page 41 for more information. 

 
VoiceMailPhoneNumber– (Windows Mobile 5 and above only) contains the 
number to dial when the voice mail notification icon is tapped. The default is an 

empty string.   
 

SuppressSmsNotifications– controls the automatic closing of the New Text 
Message notification when an SMS message is received. The default is False 
(disabled). 

 
TodayScreenInterval- specifies the number of seconds to wait before bringing 

the Windows Today screen to the foreground. The default is 10 seconds for 
Windows Mobile versions prior to Windows Mobile 6.5 and 0 (disabled) for 
Windows Mobile 6.5 and higher devices. 
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Icon Options  

See Icons on page 43 for more information. 
 

IconsDisabledCount– disables all icons for a specified number of seconds when 
AppCenter initially starts. The default is 0 seconds. 

 
AirBeamLock– disables all approved program icons when an AirBEAM update is 
in process. The default is False (disabled). 

View Options 

See View on page 44 for more information. 

 
ViewMode– controls the display of the list of approved programs. Programs will 
be in one or more columns depending on the length of the descriptions, the font 

size used, and whether the device is in portrait or landscape orientation. The 
following settings are available: 

 LargeIcons mode- default. 

 SmallIcons mode- displays smaller icons to the left of the program 

descriptions.  

 List mode- displays a single list of program descriptions centered on 
the screen. No icons are used. 

ViewTextColor, ViewBackgroundColor– controls the colors to use for the 
display of the AppCenter Launch Screen. The following settings are supported: 

 ViewTextColor- defaults to 0x000000 (Black). Controls the color of 
the text used to display the program descriptions.  

 ViewBackgroundColor- defaults to 0xFFFFFF (White). If no custom 

background bitmap is being used, the background color is used for 
the entire AppCenter background.  

ViewFontSize, ViewFontBold – controls the appearance of the font used for 
program descriptions on the AppCenter Launch Screen. ViewFontSize defaults to 
12 and ViewFontBold defaults to False (disabled).  
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Program Options 

The following settings are used for selected programs. See General on page 56 for 

more information. 

Approved Programs 

Each setting must be preceded by a program statement and the program name.  
 
Execute– full path name of the program, document or shortcut to launch.  

 
Arguments– command line arguments required for running the program. 

 
ExeName– name of the process (executable name) that is launched. This setting 
contains the name of the executable specified in the Execute entry. Note: 

Normally, an ExeName entry for a specific EXE should appear only once in the 
configuration file. See EXEs on page 57 for more information.  

 
IconFile– name of the program executable file that contains the icon to be 
displayed on the AppCenter Launch Screen. 

ApprovedWindow– window titles that are approved for this program.  
The sequence is {Window Title}|{Window Class}. Since AppCenter uses the 

executable name as the primary match, most approved programs should specify 
*|* as the only approved window. Approved windows apply only to the approved 

program under which they are entered. For example, *|* will approve all 
windows for the process specified by the EXE Name setting. The wildcard 
characters * (matches any sequence of characters) and ? (matches any one 

character) can be used anywhere in the window title or class name. See Windows 
on page 58 for more information. 

 
ReadOnly– prevents modification of the approved program when AppCenter is in 
Administration Mode. The default value is False (disabled). See Options on page 

62 for more information. 
 

HideFromUser– hides the approved program from users through AppCenter User 
Mode. The default value is True (enabled). 
 

HideMenuBar– hides the command bar for an approved program. The program's 
window is also resized to use the extra screen space. Note: Third party 

applications should be written to make use of all available screen space for the 
HideMenuBar setting to be effective.  
 

HideDoneButton– hides the done (X) button when the approved program is 
running. The default value is False (disabled). In Windows Mobile 6.5, when this 

option is selected/enabled (True), the done button is not actually removed from 
the task bar but is not functional. 
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HideStartMenu– hides the Windows Start Menu/taskbar when the approved 
program is running. The default value is True (enabled). In Windows Mobile 6.5, 
when this option is selected/enabled (True), the Windows Start Menu/taskbar is 

not actually removed from the task bar but is not functional.  
 

ShowStandardIcons– control taskbar functionality while the program is running. 
This setting is used in conjunction with the HideStartMenu setting. The default 
value is False (disabled).  

 
HideSip– hides the SIP of the approved program. The default value is False 

(disabled). In Windows Mobile 6.5, when this option is selected/enabled (True), 
the SIP is not actually removed from the menu but is not functional. 
 

AutoStart– automatically launches an approved program when AppCenter starts. 
The default value is False (disabled). See Startup on page 67 for more 

information. 
 

StartupDelay– specifies the number of seconds to wait before starting the 
program. This setting is used in conjunction with the AutoStart setting. The 
default value is 0. 

AutoStop– closes the program when AppCenter is shutdown or restarted. The 
default is False (disabled). When this setting is True (enabled), AppCenter will 

shut down the program when AppCenter terminates. AppCenter attempts to 
gracefully close the program by sending the WM_CLOSE message to all top level 
windows owned by the program. If this action is not successful, AppCenter 

terminates the program. Note: The entry in ExeName for the program must be 
correct for AutoStop to successfully close the program. 

 
RelaunchInterval– disables an approved program icon for a period of time after 
it has been initially tapped. This prevents a program from being launched multiple 

times. The RelaunchInterval setting may be necessary when launching 
programs that take a long time to initialize and load. For example, .NET Compact 

Framework. The default setting is 0. 
 
RequiredIpAddress– enables the approved program if the device has a specific 

IP address. The settings can be used multiple times to specify multiple IP 
addresses. The wildcard characters * and ? can be used. For example, 

192.168.1.*. When both RequiredIpAddress and RequiredSSID are used, both 
requirements must be met for the program to be enabled. The default setting is 
blank. See Connectivity on page 69 for more information. 

 
RequiredSSID– enables the approved program if the device is associated to a 

specific access point. The settings can be used multiple times to specify multiple 
SSIDs. The wildcard characters * and ? can be used. For example, ABC*. When 
both RequiredIpAddress and RequiredSSID are used, both requirements must 

be met for the program to be enabled. The default setting is blank. 
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AddToToolsMenu– places the approved program description on the AppCenter 
Tools menu. If HideFromUser is set to True, the program appears only on the 
Tools menu, otherwise, the program also appears as an icon on the AppCenter 

screen. The menu items appear in the order that the programs are listed in the 
AppCenter-User Configuration File. The default value is False (disabled). 

 
AlwaysLaunch- controls the launching of programs when accessed. When 
AlwaysLaunch is False (default), AppCenter will attempt to bring an existing 

program window to the foreground. When AlwaysLaunch is True (enabled), 
AppCenter will always launch the program. The default for Alwayslaunch is False 

because not all programs can handle being launched multiple times. Most 
Windows Mobile programs do an internal check for a running instance and bring 
the instance to the foreground. 

 
Note: For Athena.exe, AlwaysLaunch should be set to True. 

 
VolumeKeysAllowed– controls whether the volume hardware keys are disabled 

for a specific approved program. The default value is the current value of the 
Volume Keys Allowed setting. See Options > Keys (Phone Devices) for more 
information. 
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Appendix B Sample Configuration 

System Configuration Entry 

To reduce icon clutter in Administration Mode, the GWES, Device, Welcome, 
ActiveSync, Dialup Networking, Connection Manager, CAB Files and Mobile 

Companion or Fusion approved program entries can be replaced with Program 
System entries as shown in the following sample.  
 

Note: The Shell32 entry should be maintained as it uses different approved 
windows. 

 
Program System Execute 
Program System Arguments 

Program System ExeName  gwes.exe 
Program System ExeName  rnaapp.exe 

Program System ExeName  connmgr.exe 
Program System ExeName  device.exe 
Program System ExeName  welcome.exe 

Program System ExeName  nictt.exe (Mobile Companion) 
Program System ExeName  wclaunch.exe (Fusion) 

Program System ExeName  wceload.exe 
Program System ExeName  repllog.exe 
Program System ExeName  services.exe 

Program System IconFile   *.exe 
Program System ReadOnly  False 

Program System AlwaysLaunch  False 
Program System HideFromUser  True 
Program System HideMenuBar  False 

Program System HideDoneButton False 
Program System HideStartMenu  True 

Program System HideSip   False 
Program System AutoStart  False 
Program System AutoStop  False 

Program System StartupDelay  0 
Program System RelaunchInterva 0 

Program System ApprovedWindow *|* 
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AppCenter User Configuration File 

The following is a sample AppCenter-User configuration file: 
# 

# Version 2.0 (Build 1097) 

# 

 

# 

# Taskbar Options 

# 

HideStartMenu            True 

ShowHome                 True 

ShowAirBeam              False 

ShowWwanSignalStrength   False 

ShowSignalStrength       True 

ShowBatteryLevel         True 

ShowVolume               False 

ShowTime                 True 

ShowDate                 False 

BatteryPercentFormat     False 

ShowConnectivity         False 

ShowStandardIcons        False 

DisableStandardIconTaps  False 

TaskbarTextColor         0x000000 

TaskbarBackgroundColor   0x000000 

 

# 

# Title Options 

# 

AlternateTitle            

DisplayMacAddress        False 

DisplayIpAddress         False 

TitleFontSize            11 

TitleBold                True 

AlwaysUseAppCenterTitle  False 

 

# 

# Time Options 

# 

24HourTimeFormat         False 

RegionalTimeFormat       False 

RegionalTimeOptions      2 

 

# 

# Signal Options 

# 

AdapterName               

FusionMode               0 

MobileCompanionMode      2 

 

# 

# Admin Options 

# 

AdminLoginDisabled       False 
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# 

# Browse Options 

# 

BrowseFolder             "\Windows\Start Menu" 

BrowseFolder             \Windows\Startup 

BrowseFolder             \Windows\Programs 

BrowseFolder             "\Program Files" 

BrowseExtension          exe 

BrowseExtension          vb 

BrowseAllShortcuts       True 

BrowseControlPanel       True 

 

# 

# Close Options 

# 

AlwaysCloseExe           always1.exe 

AlwaysCloseExe           always2.exe 

NeverCloseExe            never1.exe 

NeverCloseExe            never2.exe 

 

# 

# Key Options 

# 

BlockTaskbarKey          0x00 

BlockTaskbarKey          0x0D 

BlockTaskbarKey          0x1B 

BlockTaskbarKey          0x5B 

BlockTaskbarKey          0x5C 

BlockTaskbarKey          0x86 

BlockTaskbarKey          0xC1 

BlockTaskbarKey          0xC3 

BlockTaskbarKey          0xC6 

VolumeKeysAllowed        True 

DisablePhoneKey          False 

HideSip                  True 

ShowKeyStates            False 

 

# 

# Security Options 

# 

DisableMemoryCardInsert  False 

DisableIR                False 

DisableBluetooth         False 

DisableActiveSync        False 

 

# 

# Phone Options 

# 

VoiceMailPhoneNumber      

AddWwanPhoneMenu         False 

ShowPhoneIcons           False 

BlockIncomingCalls       False 

SuppressSmsNotifications False 

TodayScreenInterval      10 
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# 

# Icon Options 

# 

AirBeamLock              False 

IconsDisabledCount       0 

 

# 

# View Options 

# 

ViewMode                 LargeIcons 

ViewTextColor            0x000000 

ViewBackgroundColor      0xFFFFFF 

ViewFontSize             12 

ViewFontBold             False 

 

# 

# Approved Programs 

# 

Program Calculator Execute           \windows\MobileCalculator.exe 

Program Calculator Arguments          

Program Calculator ExeName           MobileCalculator.exe 

Program Calculator IconFile          \windows\MobileCalculator.exe 

Program Calculator ReadOnly          False 

Program Calculator AlwaysLaunch      False 

Program Calculator HideFromUser      False 

Program Calculator HideMenuBar       False 

Program Calculator HideDoneButton    False 

Program Calculator HideStartMenu     True 

Program Calculator HideSip           False 

Program Calculator ShowStandardIcons False 

Program Calculator AutoStart         False 

Program Calculator AutoStop          False 

Program Calculator AddToToolsMenu    False 

Program Calculator VolumeKeysAllowed True 

Program Calculator StartupDelay      0 

Program Calculator RelaunchInterval  0 

Program Calculator ApprovedWindow    *|* 

Program Calculator RequiredIpAddress  

Program Calculator RequiredSSID       

 

Program Shell32 Execute            

Program Shell32 Arguments          

Program Shell32 ExeName           shell32.exe 

Program Shell32 IconFile          *.exe 

Program Shell32 ReadOnly          False 

Program Shell32 AlwaysLaunch      False 

Program Shell32 HideFromUser      True 

Program Shell32 HideMenuBar       False 

Program Shell32 HideDoneButton    False 

Program Shell32 HideStartMenu     True 

Program Shell32 HideSip           False 

Program Shell32 ShowStandardIcons False 

Program Shell32 AutoStart         False 

Program Shell32 AutoStop          False 
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Program Shell32 AddToToolsMenu    False 

Program Shell32 VolumeKeysAllowed True 

Program Shell32 StartupDelay      0 

Program Shell32 RelaunchInterval  0 

Program Shell32 ApprovedWindow    *|static 

Program Shell32 ApprovedWindow    *|worker 

Program Shell32 ApprovedWindow    *|Dialog 

Program Shell32 RequiredIpAddress  

Program Shell32 RequiredSSID       

 

Program System Execute            

Program System Arguments          

Program System ExeName           gwes.exe 

Program System ExeName           rnaapp.exe 

Program System ExeName           connmgr.exe 

Program System ExeName           device.exe 

Program System ExeName           welcome.exe 

Program System ExeName           wceload.exe 

Program System ExeName           repllog.exe 

Program System ExeName           services.exe 

Program System IconFile          *.exe 

Program System ReadOnly          False 

Program System AlwaysLaunch      False 

Program System HideFromUser      True 

Program System HideMenuBar       False 

Program System HideDoneButton    False 

Program System HideStartMenu     True 

Program System HideSip           False 

Program System ShowStandardIcons False 

Program System AutoStart         False 

Program System AutoStop          False 

Program System AddToToolsMenu    False 

Program System VolumeKeysAllowed True 

Program System StartupDelay      0 

Program System RelaunchInterval  0 

Program System ApprovedWindow    *|* 

Program System RequiredIpAddress  

Program System RequiredSSID       

 

Program "Symbol Radio" Execute            

Program "Symbol Radio" Arguments          

Program "Symbol Radio" ExeName           nictt.exe 

Program "Symbol Radio" ExeName           wclaunch.exe 

Program "Symbol Radio" ExeName           wcdiag.exe 

Program "Symbol Radio" ExeName           wcstatus.exe 

Program "Symbol Radio" ExeName           wcconfiged.exe 

Program "Symbol Radio" IconFile          *.exe 

Program "Symbol Radio" ReadOnly          False 

Program "Symbol Radio" AlwaysLaunch      False 

Program "Symbol Radio" HideFromUser      True 

Program "Symbol Radio" HideMenuBar       False 

Program "Symbol Radio" HideDoneButton    False 

Program "Symbol Radio" HideStartMenu     True 

Program "Symbol Radio" HideSip           False 

Program "Symbol Radio" ShowStandardIcons False 
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Program "Symbol Radio" AutoStart         False 

Program "Symbol Radio" AutoStop          False 

Program "Symbol Radio" AddToToolsMenu    False 

Program "Symbol Radio" VolumeKeysAllowed True 

Program "Symbol Radio" StartupDelay      0 

Program "Symbol Radio" RelaunchInterval  0 

Program "Symbol Radio" ApprovedWindow    *|* 

Program "Symbol Radio" RequiredIpAddress  

Program "Symbol Radio" RequiredSSID       
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